A Principled Technologies report: Hands-on testing. Real-world results.

A cloud abroad in Paris

A comparison of Google Sites and Microsoft
SharePoint Online
Intranet management is evolving, and with the right tools, your
employees can build internal sites quickly and easily. These
online spaces provide your staff with a centralized location
where they can get the answers they need when they need
them. The easier it is for everyone to set up and update these
important hubs of communication, the more likely your teams
will find up-to-date information within them.
G Suite and Microsoft® Office 365® both provide site
management tools—Google Sites™ and Microsoft SharePoint®
Online respectively. This report provides users with real-world
data about intranet management when the cloud tenant is
established in the U.S. and offices across the pond use these
shared resources.
We set up G Suite and Microsoft Office 365 accounts in the
United States and our team in France set up and maintained
internal sites with Google Sites and Microsoft SharePoint Online
to see which provided the better experience.1

PREVIEW A
SITE THEME
in up to

98%

LESS TIME
with Sites

EMBED A
YOUTUBE™
VIDEO
in a page in

10

FEWER STEPS
with Sites

Google Sites delivered a streamlined user experience and
responsive mobile design that SharePoint Online couldn’t
match. Google Sites not only performed 100 percent of
the routine site management task in less time, it did so with
noticeably less effort than the Microsoft Office 365 tool. Read
on to learn more.
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On the outs with your intranet?
We determined how long it took workers in Paris to create new sites and maintain existing ones with Google
Sites and Microsoft SharePoint Online. We also compared the number of steps both tools required to complete
common tasks such as adding text, images, video, and calendars to a page. Because mobility is crucial for the
multinational enterprise, we used a variety of laptops and smartphones running different operating systems (OS),
browsers, and apps to test real-world scenarios.
Before we started testing in France, we set up accounts in G Suite and Microsoft Office 365 at our hands-on
testing facility in Durham, North Carolina. We used those accounts for testing in the United States. Then, our
team in Paris used those same accounts for testing in France.
Read Principled Technologies’ five-part series “Not all clouds are created equal” to see how G Suite and
Microsoft Office 365 handled collaboration and productivity tasks in the U.S.
The following scenarios describe the results of our testing in Paris, with a hypothetical headquarters in the United
States. These scenarios give us a glimpse into how G Suite and Office 365 perform for employees that travel or
who work outside of their U.S. headquarters.

A tale of two intranets
Isabelle and Maurice are communications coordinators for rival telecommunications groups in Europe. Part
of their job is setting up and maintaining the internal sites used at their respective offices in Paris. They must
embed video, add images, and edit copy for these pages. Isabelle’s company uses G Suite and Maurice’s
company uses Microsoft Office 365.
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More time for core competencies
Routine tasks shouldn’t be complicated. Our data shows that Isabel, using Google Sites, can perform every task
in fewer steps than Maurice can using Microsoft SharePoint Online.
The real advantage isn’t only saving steps when you embed video or upload images to a page—it’s the fact that
Google Sites is generally easier to use than Microsoft SharePoint Online (see pages 6 and 7).

Create new page
5 steps

4 steps

Change site/page theme
4 steps

2 steps

Embed YouTube video in page
15 steps

5 steps

Add text to a page
3 steps

2 steps

Move inserted image
6 steps

1 step

Resize inserted image
7 steps

2 steps

Add image to page from computer (upload)
9 steps

3 steps

Add calendar
4 steps

3 steps

Add bulleted list and one item
7 steps

3 steps

SharePoint Online
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Isabelle outscores Maurice 3-1
Isabelle and Maurice are creating new pages and sites for their company intranets. Both need to build new
group sales history pages for their sales teams, prepare commission breakdown pages for HR, and create
contract sites for their legal teams.
Our results show that Google Sites helps Isabelle finish her tasks in less time than Maurice can with SharePoint
Online. Creating new sites on her Windows® 10 laptop takes Isabelle 3 seconds. It takes Maurice over 10
seconds longer to do the same thing with SharePoint Online on the same laptop model! Simply put, Isabelle can
create three new sites in the time it takes Maurice to create one. This advantage means Isabelle can start working
on other objectives while Maurice is still far from done with his list.
Once each new project site is ready to go, Isabelle lets her coworkers know via email that their new portals
are up and running. With Google Sites, Isabelle’s team sees her emails sooner than Maurice’s coworkers with
SharePoint Online.

Create a new site
in up to

77

%

less time

Windows 10
13.3 sec

3.0 sec

OS X®
12.1 sec

3.9 sec

with Sites

Create a new
blank page in up to

72

%

less time

Windows 10
2.2 sec

0.6 sec

OS X
2.2 sec

0.8 sec

with Sites

Invite/share via
email in up to

41

%

less time

Windows 10
3.4 sec

2.0 sec

OS X
3.4 sec

2.6 sec

with Sites

SharePoint Online
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Fast tools for staying up to date
Isabelle and Maurice now need to update their respective sites by changing the site’s color scheme and
reviewing individual team pages.
It takes Isabelle under a second to preview a site theme with Google Sites on her Windows 10 laptop. In
contrast, Maurice is stuck staring at his computer screen for over half a minute as he waits for SharePoint Online
to preview the changes. This is the kind of delay that makes busy employees avoid certain tasks.
Opening a page for editing takes Microsoft SharePoint Online 1.5 times as long as it takes Google Sites. When
workers like Isabelle and Maurice are reviewing dozens of team pages and adding new information to existing
files, the time it takes to complete these tasks really adds up. And when they don’t have the fastest tools helping
them, routine tasks require more time than they should.

Preview a site
theme in up to

98

%

less time

Windows 10
37.6 sec

0.5 sec

OS X
19.7 sec

0.8 sec

with Sites

Open an existing
page for editing
in up to

31%

less time

Windows 10
1.9 sec

1.3 sec

OS X
1.9 sec

1.7 sec

with Sites

SharePoint Online
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Get the whole picture
Saving time and steps is important, but those savings aren’t the only difference between Google Sites and
Microsoft SharePoint Online.

The Google Sites experience
Google Sites presented our testers in Paris with a consistent experience across devices, including Android™ and
iOS smartphones. It also created responsive pages that scaled properly on both laptop and mobile screens.

What a page editor on desktop sees
SharePoint Online

Google Sites

What a user on desktop sees
SharePoint Online

Google Sites
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The Microsoft SharePoint Online user experience
Microsoft SharePoint Online has some mobile support, but what you see when designing a SharePoint site isn’t
always what you get. For example, in the screenshot on the left, the page title’s formatting doesn’t match how
it appears in the SharePoint Online editor screen on the previous page, and you see only half of the image; you
have to scroll horizontally to see the whole thing.
In contrast, Google Sites was mobile-friendly and didn’t have any issues fluidly scaling from mobile screens to
laptop screens.

What a mobile user sees
SharePoint Online

Google Sites
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Conclusion: Google Sites makes routine tasks less complicated
Internal sites provide your employees with the information they need in one convenient location. When these
sites are easy to maintain, they bring even more value to users, because it’s not difficult to keep that important
information up to date.
In our hands-on testing, Google Sites streamlined the process of site building and maintenance—each task
took fewer steps. Every Microsoft SharePoint Online step-by-step process was more time-consuming and
complicated. Google Sites also provided users with a consistent experience across devices, a consistency that
was lacking in our SharePoint Online experience. Overall, we found that accomplishing day-to-day tasks using
Google Sites was simpler and more intuitive. When we attempted the same tasks with SharePoint Online, we
experienced up to 98 percent longer wait times.
Want to try out the tests yourself? Follow the methodologies at the end of
the report.
This is the fifth report in our five-part series that explores the
performance of Microsoft Office 365 and G Suite when
set up in the United States and accessed abroad
from Paris. These scenarios show how the two
suites perform for employees that travel or
who work outside of their U.S. headquarters.
Read the full series for a more complete
picture of each cloud’s performance for
multinational companies.

Additional reports in the “A cloud abroad in Paris” series:
A comparison of Google Docs™ and Microsoft Word Online
A comparison of Google Hangouts™ and Skype® for Business
A comparison of Google Drive™, Microsoft OneDrive® for Business, and SharePoint Online
A comparison of Gmail™ and Outlook®

1

For our testing, we used the rebuilt Google Sites via the Google Sites Early Adopter Program: https://cloud.googleblog.
com/2016/06/powering-a-more-connected-and-collaborative-enterprise.html
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On August 18, 2016, we finalized the hardware and software configurations we tested. Updates for current and
recently released hardware and software appear often, so unavoidably these configurations may not represent
the latest versions available when this report appears. For older systems, we chose configurations representative
of typical purchases of those systems. We concluded hands-on testing on August 18, 2016.
On September 29, 2016, Google rebranded Google Apps for Work as “G Suite.” We completed our testing
prior to that rebranding.

Appendix A – What we tested
The table below shows the system information for the mobile devices we tested.
System

Apple® iPhone 6s Plus

Google Nexus™ 6P

Vendor

Apple

Qualcomm®

Model number

A9 + M9 coprocessor

Snapdragon™ 810

Core frequency (GHz)

1.85

1.95 + 1.55

Number of cores

2

8 (4 + 4)

Amount (GB)

2 (built-in onboard)

3 (built-in onboard)

Type

LPDDR4

LPDDR4

Vendor

Imagination® Technologies

Qualcomm

Model number

PowerVR® GT7600

Adreno™ 430

Amount (GB)

64

64

Type

NAND Flash

NAND Flash

Wireless internet

802.11ac (802.11a/b/g/n compatible)

802.11ac (802.11a/b/g/n compatible)

Cellular

LTE Advanced

LTE Advanced

Bluetooth

4.2

4.2

Type

Lithium-polymer

Lithium-polymer

Size

Integrated

Integrated

Rated capacity (Wh)

10.45

13.11

Size

5.5”

5.7”

Type

LED-backlit widescreen Multi-Touch

AMOLED widescreen Multi-Touch

Resolution

1,080 x 1,920

1,440 x 2,560

Processor

Memory

Graphics

Storage

Connectivity

Battery

Display
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System

Apple® iPhone 6s Plus

Google Nexus™ 6P

Front-facing (MP)

5 (720p FaceTime® HD)

8

Rear-facing (MP)

12 (iSight®)

12.3

Vendor

Apple

Google

Name

iOS

Android

Build number or version

9.3.2

6.0.1

Height

6.23”

6.27”

Width

3.07”

3.06”

Depth

0.29”

0.28”

Weight (oz.)

6.77

6.27

Camera

Operating system

Dimensions

The table below shows the system information for the laptops we tested.
System

Apple 13” MacBook Air® (Early 2015)

Lenovo® ThinkPad® X1 Carbon

Vendor

Intel®

Intel

Model number

Core™ i5-5250U

Core i7-6600U

Core frequency (GHz)

1.6 (up to 2.7 Turbo Boost)

2.6 (up to 3.4 Turbo Boost)

Number of cores

2

2

Cache

3MB L3

4MB L3

Amount (GB)

8 (built-in onboard)

8 (built-in onboard)

Type

LPDDR3

LPDDR3

Speed

1,600 MHz

1,866 MHz

Vendor

Intel

Intel

Model number

HD Graphics 6000

HD Graphics 520

Amount (GB)

256

256

Type

PCIe-based flash

PCIe NVMe™ SSD

Processor

Memory

Integrated graphics

Storage
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System

Apple 13” MacBook Air® (Early 2015)

Lenovo® ThinkPad® X1 Carbon

Wireless internet

802.11ac (802.11a/b/g/n compatible)

802.11ac (802.11a/b/g/n compatible)

Bluetooth

4.0

4.1

USB

2 x 3.0

3 x 3.0

Thunderbolt

2x2

N/A

Video

N/A

1 x HDMI®, 1x Mini DisplayPort

Type

Lithium-polymer

Lithium-polymer

Size

Integrated

4-cell

Rated capacity (Wh)

54

52

Size

13.3”

14”

Type

LED-backlit glossy widescreen display

LED IPS

Resolution

1,440 x 900

1,920 x 1,080

Touchscreen

No

No

Vendor

Apple

Microsoft

Name

OS X El Capitan

Windows 10 Pro

Build number or version

10.11.6

1511, OS Build 10586.318

720p FaceTime HD

720p

Height

0.11” to 0.6”

0.6”

Width

12.8”

13.1”

Depth

8.94”

9.00”

Weight (lb.)

2.96

2.58

Connectivity/expansion

Battery

Display

Operating system

Camera
Front-facing
Dimensions
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Appendix B – How we tested
About our testing
Network infrastructure
We used two of each device under test. We connected the two devices in each pair to separate wireless networks. We connected the devices
to the 5GHz band of identical, 802.11 ac-based TP-Link AC1750 wireless routers. We configured each router identically but set them to use
different channels, to minimize traffic from nearby networks.

Devices
• Lenovo ThinkPad X1 Carbon (Windows 10)
• Apple 13” MacBook Air (OS X El Capitan)
• Google Nexus 6P (Android 6.0.1)
• Apple iPhone 6s Plus (iOS 9.3)

OS and browser versions
• OS X El Capitan
yyChrome™ 52.0.2743.116
yySafari® 9.1.2 (11601.7.7)
• Windows 10
yyChrome 52.0.2743.116 m
yyEdge 38.14393.0.0
• Android 6.0.1
• iOS 9.3.4

Running the laptop tests
Measuring the time to create a new site
1.
2.

In Google Chrome, navigate to the dashboard page for the site management service being tested.
Create the site:
• In Google Sites, simultaneously click the Create New Site button and start the stopwatch.
• In SharePoint Online, click the Create Site button and provide a name, then simultaneously click Create and start the stopwatch.

3.

Stop the stopwatch:
• In Google Sites, stop the stopwatch when the new site appears and has fully loaded.
• In SharePoint Online, stop the stopwatch when the new site’s dashboard appears and has fully loaded.

4.

Record the result.

Measuring the time to share site via email
1.
2.

Prepare another notebook (the same model as the one being used for testing) by navigating to the browser-based email client for the
platform under test, Gmail or Outlook Online.
On the notebook under test, prepare to share the site:
• In Google Sites, click the Add Editors button, provide the email address being used on the other notebook, then simultaneously click
Done and start the stopwatch.
• In SharePoint Online, click the Share button, provide the email address being used on the other notebook, then simultaneously click
Share and start the stopwatch.

3.
4.

When the invite email appears in the inbox on the other notebook, stop the stopwatch.
Record the result.

A cloud abroad in Paris: a comparison of Google Sites and Microsoft SharePoint Online

January 2017 | 12

Measuring the time to create a new blank page
1.
2.

In Google Sites, navigate to the Pages tab, or in SharePoint, navigate to the Site Contents page, and click Site Pages.
Create a new blank page:
• In Google Sites, click the Add Page button, provide a name for the page, then simultaneously click Done and start the stopwatch.
• In SharePoint Online, click the New button, provide a name for the page, then simultaneously click Create and start the stopwatch.

3.

Stop the stopwatch:
• In Google Sites, when the new page has fully loaded and is editable, stop the stopwatch.
• In SharePoint Online, when the new page appears in the editor and is editable, stop the stopwatch.

4.

Record the result.

Measuring the time to open an existing page for editing
1.

Open an existing page:
• In Google Sites, navigate to the site under test, then simultaneously click the button for an existing page (that is not currently open in
the editor) and start the stopwatch.
• In SharePoint Online, navigate to an existing page, then simultaneously click the Edit button and start the stopwatch.

2.
3.

When the page appears in the editor and is fully loaded, stop the stopwatch.
Record the result.

Measuring the time to preview a site theme
1.
2.
3.

In Google Sites, click the Themes tab, or in SharePoint, click the What’s your style? button.
Simultaneously click a theme (other than the one you’re currently using) and start the stopwatch.
Stop the stopwatch:
• In Google Sites, when the new theme loads on the page in the editor, stop the stopwatch.
• In SharePoint Online, when a preview of the new theme loads, stop the stopwatch.

4.

Record the result.

Measuring the number of steps to add bulleted list and one item
Google Sites
1.
2.
3.

In the Insert menu, click Text box.
Click the bulleted list icon.
Type item text.

SharePoint Online
1.
2.
3.
4.
5.
6.
7.

Click add an app.
Click Custom List.
Type name.
Click Create.
Click New Item.
Enter a title.
Click Save.

Number of steps to add calendar
Google Sites
1.
2.
3.

In the Insert menu, under Google Embeds, click Calendar.
Click a calendar in the list to select it.
Click Insert.

SharePoint Online
1.
2.
3.
4.

Click Add lists, libraries, and other apps.
Click Calendar.
Provide name.
Click Create.
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Number of steps to add image to page from cloud
Google Sites
1.
2.
3.
4.

In the Insert menu, click Images.
Click the Google Drive tab.
Click an image to select it.
Click Select.

SharePoint Online
1.
2.
3.
4.
5.
6.
7.

Click Edit.
Click Insert tab.
Click Picture.
Click From SharePoint.
Click existing image.
Click Insert.
Click Save.

Measuring the number of steps to add image to page from computer (upload)
Google Sites
1.
2.
3.

In the Insert menu, click Images.
Drag an image file to the upload box from a local folder.
Click Upload.

SharePoint Online
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click Edit.
Click Insert tab.
Click Picture.
Click From Computer.
Click Choose File.
Select existing image.
Click Open.
Click OK.
Click Save.

Number of steps to resize inserted image
Google Sites
1.
2.

Click the image in the editor.
Click and drag one of the circles on the corners to resize it.

SharePoint Online
1.
2.
3.
4.
5.
6.
7.

Click Edit.
Click the image you want to resize.
Click the Image tab.
Click in either the Horizontal Size or Vertical Size fields.
Type the desired width or height in pixels.
Press Enter.
Click Save.
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Number of steps to move inserted image
Google Sites
1.

In the editor, click and drag the previously embedded image to the desired location.

SharePoint Online
1.
2.
3.
4.
5.
6.

Click Edit.
Click the previously embedded image.
Click Image tab.
Click Position drop-down menu.
Click a position.
Click Save.

Number of steps to add text to page
Google Sites
1.
2.

In the Insert menu, click Text box.
Enter the text.

SharePoint Online
1.
2.
3.

Click Edit.
Enter text.
Click Save.

Measuring the number of steps to embed YouTube video in page
Google Sites
1.
2.
3.
4.
5.

In the Insert menu, under Google Embeds, click YouTube.
Enter a search query.
Press Enter.
Click the desired video.
Click Select.

SharePoint Online
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.

Click Edit.
Click Insert tab.
Click Embed Code.
Navigate to http://www.youtube.com in another tab.
Enter search term or phrase.
Press Enter.
Click the desired video.
Click Share.
Click Embed.
Select Embed Code.
Copy embed code.
Return to the tab in which SharePoint is open.
Paste embed code in the Embed dialog in SharePoint.
Click Insert.
Click Save.

A cloud abroad in Paris: a comparison of Google Sites and Microsoft SharePoint Online

January 2017 | 15

Number of steps to change site/page theme
Google Sites
1.
2.

Click the Themes tab.
Click a theme to apply it.

SharePoint Online
1.
2.
3.
4.

Click What’s your style? Change the look of your site.
Click the desired theme.
Click Try it out.
To apply the theme, click Yes, keep it.

Number of steps to create new page
Google Sites
1.
2.
3.
4.

Click the Pages tab.
Click the Add page icon.
Type in the desired page name.
Click Done.

SharePoint Online
1.
2.
3.
4.
5.

Click Site Contents.
Click Site Pages.
Click New.
Type in the desired page name.
Click Create.

This project was commissioned by Google.
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.
DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:
Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result.
In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of the
possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with Principled
Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.
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